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Introduction

Welcome to Ferrari Grand Prix, the program that captures the
intense excitement of racing.

Ferrari Grand Prix allows you to realize the dream of becoming
a race car driver, of driving one of the world’s most exotic, and
fastest automobiles, in the world’s most popular and beloved
racing class —Formula One.

Formula One is followed world wide. The world championship
circuit competes in the United States, Canada, Monaco, Great
Britain, France, Germany, Portugal, Austria, Australia, and ltaly,
among other countries.

Now you can strap yourself into an F1 Ferrari. Get ready, you
will learn to “straighten out the curves” and “feel the groove”.
You'll take your Ferrari to the very limit of it's abilities, out-race
your opponents and take the checkered flag.

But I'm sorry to say, you won't be a top notch driver the first
time around the track. Nope, it takes hard work, long hours of
practice, and pounds of salty sweat. Driving one of these high
powered beasts takes a lot out of a guy {or gal}. Your only
consolation is that you will not be risking your life or wasting
millions of dollars.

When you've mastered Ferrari Grand Prix, take your helmet
off and pat yourself on the back, you will have earned it. Imagine
driving your own car at 150 mph and you may realize the scope
of the task you've taken on. (The speed you experience in Ferrari
Grand Prix is a realistic representation of actual speed to scale.)

Remember: if you want to relax, go down to the gas station
and watch the cars fill up. If you're looking for a thrill, for some
tense excitment, if you're ready to concentrate on unbridled
power, pull out Ferrari Grand Prix and go to it.

Enjoy.



Quick Instructions

Note: Ferrari Grand Prix will not work with Switcher nor can it
be put on a hard disk. If you run Ferrari Grand Prix under HFS be
sure to turn the Ram Cache option off. Ferrari Grand Prix will not
operate properly with the Ram Cache. It is also touchy about
other programs being in memory with it. Ferrari Grand Prix may
bornb with any memory resident program.

The Program

Ferrari Grand Prix has two modes—pause mode and drive
mode. The pause mode, where the program begins, allows you
to use the mouse in the typical Mac way. (Select puil down
menus and use desk accessories.) This mode is characterized by
the standard arrow-type pointer.

In drive mode, the pointer changes to a black rectangle and
cannot be moved up and down, only left and right. You'll also
notice the steering wheel and tires will, at times, move corres-
ponding to mouse movement. In this mode you cannot access
any of the menus or do anything other than drive. The mouse
button in this mode will center the steering wheel. You must
“pause’’ to change options or to quit.

To enter the drive mode, click the mouse anywhere in the
document window. If you have paused during a curve, you'll
want to click the mouse at the approximate spot you had when
you paused.

To exit the drive mode, press the Backspace or Q" keys.

Driving your Ferrari

The foliowing is a very brief description of how to drive Ferrari
Grand Prix. Complete instructions can be found later in the
manual.

Ferrari Grand Prix may seem difficuit to steer at first. Here's
how to steer: watch the road up near the horizon, just under the
rectangular cursor box. Don’t watch the steering wheel or your
front tires. Keep the road centered in front of you. (Centered
means above the steering wheel.) Steering is sensitive, so be
gentle in your mouse movements. It doesn’t take much to move
the car on straights, it takes very slight, sometimes quick,
movements. Remember, twisting the mouse doesn’t work, move
the mouse side to side. The cursor box actually shows to where
you are currently steering. Use this box to help you steer and to
train you where to look on the track. Look at the farthest point
of the track you can see. This will keep you on the course and
also you will see upcoming curves as soon as possible.
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Try this technigue of holding the mouse: put your wrist down
on the table, just behind your mouse, holding your hand up.
Now, lightly grab the mouse, keeping your wrist on the table.
Keep your wrist on the table while you move the mouse. Notice
how you can make very fine or very quick movements of the
mouse. This is somewhat like strumming a guitar in that the
wrist remains still, and the hand pivots at the wrist. The key here
is keeping your wrist on the table. When you lift your wrist it
imbalances your body and it's difficult to tell how far you've
moved the mouse and where you were before you moved the
mouse. Of course, you will need to lift the mouse, from time to
time, to reposition it in the center of it's area.

Make sure your mouse is rolling well, an improperly operating
mouse makes Ferrari Grand Prix impossible.

On curves, watch the white at the inside of the curve and keep
it centered in front of you. Be ready to straighten out when the
next straight arrives. After you drive awhile you might read the
chapter entitled, "Tips and Common Mistakes”. This chapter
can quickly improve your driving skills. One tip here—steering at
high speeds is more difficult than steering at low speeds. Learn
to steer at low speeds before you try to go really fast.

In racing, you are either accelerating or braking, therefore,
Ferrari Grand Prix does not have an accelerator pedal. It is
assumed that when the car is in gear, it is floored. When you
brake, the gas is off and the gearbox is in neutral.

See the callouts on page 16. This iliustration explains each of
the Ferrari’s readouts.

Learning to Race

Racing consists of steering, shifting, braking, setting up for
curves, passing and taking pit stops. It is advisable to take each
step one at a time. Trying to put it all together from the first time
you drive can not only be nerve-racking, but needlessly
frustrating. Later in this manual, | will discuss each of these skills
and how to master them. For now, try driving the course in 2nd
gear. No shifting, no braking. Work on controlling your Ferrari
and getting the feel of using the mouse as a steering wheel. If
you feel comfortable in 2nd, try the course in 3rd. If the car goes
completely off the course, the program shifts you into 1st gear.
Drive back on the course and shift into second. (if the course
compiletly disappears from the screen, you'll have to coast back
to the track. Once you're completely back on the course, you
can shift into first and continue racing.)

Go ahead and play with Ferrari Grand Prix for awhile, then
come back to the instructions to become an accomplished race
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car driver. To begin, click once in the window to enter the drive
mode, then click again to center the steering wheel. The Ferrari
is in neutral and you can hear it revving. Press ‘1" for first gear
and you will start moving. When you hear the engine wind up,
shift into 2nd gear by pressing “2°".

Phota courtesy of Ferrari, ltaly

The Menus

Thare are six menu categories—the Apple menu, File, Edit.
Game, Opponents, and Famous Drivers. i

The File menu contains New, Open, Save, Save As, and Qwit.

Mew restarts all cars at the beginning of the track and clears
current lap, average lap, and elapsed times, alse laps finished,
laps to go, and average mph. These are all found on the screen.

Open, Save, Save As, and Quit are self explanatory.

One note about Quit, unless you just saved, you'll be asked if
you want to quit without saving. If you quit without saving,
you'll lose your best lap time and the top three best lap times. If
vou've designed a race course, you'll also lose that, unless
you've saved it earlier.

The Edit menu has only one item initially active —Show Track.
When this is selected the screen changes to the “‘design course”
section of Ferrari Grand Prix. Ongce there, the rest of the items
become active. You'll see Cut, Copy, Paste, Clear, Undo, and
Revert. Cut, Copy, Paste, and Clear only work inside of Ferrari
Grand Prix, you can’t paste from or to another application. The
“Designing Courses’”’ chapter goes into great detail about this
section of the program. To exit the design course section, click
the close box. One more note, you can’t open or save a course
while in the design section.

The next menu heading is Game. This menu is organized into
sections. The first section is Load Background, Change Driver
Name/Level, and Keyboard Assignments. Load Background
allows you to load a different background file. Backgrounds can
be designed using MacPaint. All backgrounds must have the
“ Bkg" ending on their names. More on drawing backgrounds
can be found in Designing Courses”’.

Change Driver Name/Level presents you with the same dialog
message you see when the program is started. It allows you to
change the name you've entered. This name is used in Famous
Drivers. It alsc presents you with three game levels, Beginner,
Intermediate, and Expert. These levels don't actually effect the
play of the game, they only change where the cursor is
dispiayed. Beginner puts the cursor box just above the track.
The cursor shows you where your Ferrari will be down the
course. It will make steering easier. When you select
Intermediate, the cursor box moves up to the top of the window.
You can still “see’’ where you're steering to, but now you can
concentrate more on the course. Having the cursor high makes
steering a little more difficult. Expert removes the cursor entirely.
When you become a hot shot driver give this a try. You’ll find it
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a little more difficult than intermediate. In all three modes the
point is to watch the track at the farthest visable point. This idea
doesn’t change, and you should always concentrate on locking
at the “end” of the track.

The last item in the first group is Keyboard Assignments. This
option allows you to change the keyboard assignments. The
default keys are 1, 2, 3, 4, and 5, corresponding to the gears, the
tilda, the key to the left of the 1" key will put the Ferrari into
neutral, space bar will apply the brake, “Q" will enter pause
maode, “S" will toggle the sound, and “C" will toggle the cursor
between visable and nonvisable. (Making the cursor invisable is
the same as selecting expert mode.} The program will always
start up with these default settings. If you want the keyboard
assignments to stay changed, remember to save your position
when you guit. Then, next time you run Ferrari Grand Prix,
simply load your file.

The next section under Game includes Collision, No Collision,
and Gearing.

You'll see a check mark by Collision or Mo Collision depending
on which is selected. Of course, Ne Collision means you can’t
collide with the other cars and Collision means you can. Gearing
allews you to change the top speed of each gear. This is useful
for fine tuning your Ferrari to a particular course.

The next twe items are Clear Best Lap Time, and Clear
Opponents Best Times. Clear Best Lap Time zeros your own best
lap time that is displayed inside your Ferrari.

Clear Opponents Best Times allows you to clear one, the
other, or both of the opponents best lap timas.

Neither of these items will affect the Course Best Laps option
in the Famous Drivers menu.

The last three options under Game are Practice, Start Race,
and Current Positions.

Any time you're driving, you are either in Practice or Race
mode. After you've practiced a course, you’'ll want to start a
race. When you select Start Race, you'll be asked for the
number of iaps in the race and pit stop frequency. Number of
laps can be 1 to 999. (Formula One races are designed to be
close to, but not over iwo hours.)

Pit stop frequency is the number of laps before a pit stop is
required. Enter zero for no pit stops. If you want pit stops, be
sure to include the pit piece in any course you design.

The length of a pit stop depends a lot on your luck. Pit stops
range from 6 or 7 seconds to 16 seconds or more. If you have a
short race with a lot of pit stops, they can play a major role in
who wins the race.
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In either mode, practice or race, you can enter the pit area at
any time. (See Advanced Training for how to enter the pit.)
During a race you'll be prompted, by a flashing black arrow
located in the upper right part of the screen, when a pit stop is
necessary. You may be able to siretch a pit stop one or maybe
two laps.

Upon completion of a race, you'll be alerted as to your finish
position, the elapsed time of the winner, and the program will
enter the practice maode.

The last item is Current Positions. This option shows which
position each car is in, elapsed time, time off the pace, and
current partial lap. Note: times in Ferrari Grand Prix are hundreds
of seconds, seconds, minutes, and sometimes hours.

The second to the last menu is Opponents. In this menu are
Whistle McGee, Stockton Stockman, and Show Opponents
Speed.

Whistle McGee and Stockion Stockman are your two
computer controlled opponents. Selecting either driver presents
that driver's performance specifics, and optional limitations. This
is where you can slow an opponent down to create a more
competitive race. To make an opponent the siowest possible,
select 2nd gear as his top gear, select Good Driver, which makes
him drive slower in the curves, and say vyes to the question,
“This car shifts into first if you go off course”.

Show Opponents Speed prints two small numbers inside and
to the upper right part of the window. The first number is
Whistle McGee's speed, in MPH, and the second number is
Stockton Stockman’s speed.

The last menu item is Famous Drivers. It has just two items—
Course Best Laps, and Clear Course Best Laps.

Course Best Laps displays the top three lap times in minutes,
seconds, and hundreds of seconds. The number after the lap
time is the average MPH for that iap time. This information will
be lost when you exit the program unless you do a Save or Save
As.

Clear Course Best Laps will, cbviously, clear the top three lap
times.

These then are the menu items for Ferrari Grand Prix.



Advanced Training

So you've driven around awhile, handicapped the opponents,
and won a few races. You've gotten pretty good at Ferrari Grand
Prix. Now it's time to become a great driver.

Racing consists of steering, shifting, braking, setting up for
curves, passing opponents, and taking pit stops. Practice these
six items separately, and together, and you will become a great
driver.

Steering

Steering can be hard or easy. The most important thing about
steering, about racing in general, is to think a little bit ahead of
your current position. Think a little bit ahead and steering can be
easy (by easy, | mean as easy as it gets), get behind the car and
steering is hard. Once you get a little bit behind, the situation
invariably escalates. Here's a typical example—you're zipping
down a straight at 200+ mph and your Ferrari is slowly drifting
off the course. If you're thinking ahead, you’'ll correct the car
before it drifts. By allowing the car to drift, you set yourseif up
for an oversteer back into the straight, followed by another over-
steer, until you lose control and are off the course.

A great exercise for high speed steering is to set up a course
that consists of straights only, use 20 or so. Accelerate to the
speed you are having trouble at and practice changing lanes.
Keep the cusor box over the end of the straight. Work all the
way up to 5th gear and use the highest 5th gear ratio which will
put you at over 200 mph. Driving at 200 mph is always a bit
nerve-racking, but you'll find you can get a pretty good degree
of control. Be sure to watch the farthest visable peint of the
course.

This practice will help your general control, passing
opronents, and setting up for curves. The other steering
technique is cornering. One way to get good at cornering is to
design a simple oval course. Start with 1000 foot radius curves.
An oval course is easy to memarize, and you'll be working only
on left or right hand curves at a time. With 1000 foot radius
curves, work all the way up to 5th gear. Once you feel
comfortable with right hand curves, change the course to left
hand curves. Next, try this approach on sharper curves. Curve
speeds are—1000" radius=>5th gear, 500" and 250" radius=4th
gear, 125 radius=3rd gear, and 62’ radius=2nd gear. These are
guide line gears. For instance, you may not be able to take a 250’
curve in 4th with the highest speed gear option. Also, you can
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take a short curve faster than a long one. By long and short
curve I'm referring to the number of degrees around a circle.

Notice that to take sharper curves at high speeds you must
move the mouse quicker. If you are not making a curve at all
(assuming it’s physically possible at your current speed) then you
are not moving the mouse quick enough, not moving it far
enough, or moving it too late. These three items hold true for
exiting a curve also, only you're straightening the car rather than
turning it. if you find your car entering a skid, and perhaps
eventually rolling, during a high speed curve, then you have
reached the limit of the friction between the tires and the track.
You can’t turn that sharp, going that speed. Your only
alternative is to SLOW DOWN. You can also enter a skid
sometimes by jerking the steering wheel at a high speed.

You want to commit steering, as much as possible, to your
subconscious. Try to make steering second nature. You may
notice the first few times you try to brake, you forget to steer. It
takes a little practice to put it all together.

Shifting

Shifting is basically a matter of working through the gears, to
accelerate as fast as possible. Gear ratios will effect when you
can shift gears. Experiment. You want to go as fast as possible
on straights.

Ferrari Grand Prix will shift your car into first any time you go
completely off the course. The time this takes can be costly
during a race. The trick is to get back on the course as quickly as
possible. As soon as one tire gets back on the track, slam your
Ferrari into 2nd.

| find it comfortable to place my 3rd finger on the 3 key (which
is the 3rd gear key} and my thumb on the space bar (which is the
brake key). Get so you don't have to look down to shift.

Braking

The brake has four settings. The first time you press the brake
{space bar} your Ferrari will go into neutral, and light braking will
be applied. A second press of the space bar will apply medium
braking, and the next press is hard braking. If you get too
excited and press the brake one more time, you will lock the tires
up and enter a skid. You know you're in a skid because the
sound changes and the tires go white. To recover from a skid,
you must press the neutral key (the key to the left of the 1"
key), this insures you're in neutral, which takes the brake off.
The tires will return to black if you stop skidding.

With shifting, you want optimum acceleration. Similarly, with
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braking, you want maximum slowing. The idea in racing is to
wait as long as possible before braking, then use maximum
braking to slow for a curve.

Shift into the proper gear once vour Ferrari has slowed to the
desired curve speed.

This can be tricky since you have to steer through the curve
and know when to sift into gear. One way to know when to shift
into gear is, obviously, to look at your MPH. A better way is to
know when to begin braking, called the brake point, so that you
hit the correct speed as you enter the curve. | don‘t want to
sound like a broken record so this is the last time I'll say, “this
takes practice”. Go back to an oval course with long straights
and work on recognizing brake points.

Setting up for curves

Listen to race car drivers and you'll hear them talk about
hitting the best line through a curve.

The theory is to enter a curve from the outside of the course,
then turn for the apex. When you reach the apex, accelerate out
of the curve. The apex is that part of the curve where you reach
the innermost part of the track. It's also the point when vou
switch from hard braking to acceleration. It looks like this:

™ APEX

Racers call this, “straightening out the curve”.

As you accelerate out of the curve, you will wind up on the
outside of the course. You may have to alter the exit line of the
curve depending on what is coming up. For example, if a right
hand curve is immediately followed by a left hand curve, you'll
want to stay at the inside of the course longer to set up for the
next curve.

When you hit a curve just right, you'll “feel the groove’ and
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your Ferrari will almost feel like it's steering itself. It's great fun
when you feel the groove. So the trick to setting up for a curve
is to steer to the outside of the course when you see a curve
coming. (OF course, if you memorize the course you can steer to
the outside before you see the next curve.)

Remember that the faster you go, the quicker you'll have to
move the mouse when you turn for the apex.

Little bends are a little hit different since you probably will not
want to brake for them. Curves 1, 3, and 4 in the default course
are what | consider little bends.

Again, set up by steering to the outside of the course. Then,
just before the curve, make a quick turn to the inside of the
bend. The “line” looks like this:

Driving bends are one of my favorite things about racing.
Curves 3 and 4, on the default course, are probably the easiest
place to "“feel the groove”'.

The best way to set up for a curve is to have the course
memorized. it can cause tension if you have to wait until you can
see the direction of the next curve before you set up.

Conversely, if you already know which side of the course to be
on, you can concentrate on other things, like where to brake or
passing opponents.

Remember to watch the course at the farthest visible point.
This will allow you to see an upcoming curve as early as
possible. The telltale sign of a distance curve is a lot of bunched
up road posts. If you memorize the course, you'll know what
type of curve is coming up before it's visible.

Passing

Passing another car can be the straw that breaks the camsl’s
back.

The first thing that happens when you try to pass is you look
at the other car. When you do this, BAM, you're off the course.
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You have to "see” the other car, but you must look at the next
curve.

Also, remember to brake or accelerate. Your opponent won't
wait for you, if you forget to shift.

Another thing to remember is you don't have to pass as soon
as you catch up to a car. An exception to this is if the other car
is heavily handicapped and you've got enough speed to easily
overtake him.

In a competitive race, there are probably only three places to
pass—in the pit, entering a curve, and exiting a curve.

The easiest place to pass is, of course, in the pit. It's not too
tough when the opponent’s tires are 6 inches off the ground.

Just about every pass in Formula One racing (at least when
the leaders are concerned) happens entering a curve. The idea is
to “‘out-brake’” the opponent. It's a test of nerves because you
wait until the other guy brakes before you hit the brakes. This
way you'll nudge into the curve before he does, and he'll give
way. (He'd better give way or you'll both be in trouble.) Passing
while in the curve is dangerous and only a very desperate, or
reckless, driver will attempt it.

The last place you can get around an opponent is coming out
of a curve. If you can get on the gas a split second before the
other guy does, and still make the rest of the curve, you'll reach
top speed down the straight a little before he does. You'll be able
to whiz past him. But don’t forget about the next curve, brake
too soon and he'll pass you back, brake too late, and it's curtains.

To get used to driving in traffic, set both opponents’ top gears
to 2nd. (You can use 3rd if you'd rather.) Let them get just in
front of you, then follow them around the course a few times.
This will teach you to watch the course instead of the
competition. Try accelerating past them, then let them pass you.

Since the opponents don’t brake on the default course when
driving in 2nd or 3rd, you won't get a chance to practice the real
passing technique outlined above. You don’t get a chance to try
"out-braking”” the opponents until you're an accomplished racer,
going flat out around the course.

But at least when the time comes, you'll already have learned
to watch the course and you can concentrate on what you're
doing.

As | mentioned before, it's best not to try to pass immediately,
when you first come up on an opponent. Pick a spot on the
course you feel comfortable passing on, and wait to make your
move.

If you're coming up on an opponent, but not ready to pass,
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slip your Ferrari into neutral. This is analogous to letting up on
the gas pedal.

If you're approaching another car and a coliision is imminent,
try light or medium braking. Be sure to enter a gear or neutral as
soon as the collision has been avoided.

Pit Stops

The first pit stop is reserved for you. Entering the pit takes a
little practice. Slow to about 40 mph at the start of the pit and
steer down the pit lane. As you get close to the pit stop area,
slow to 15 mph. Brake to a stop when you drive across the first
white line. You must be pretty well centered in the pit area and,
of course, you must stop in your own pit stop.

It looks like this:

E=e=—————=——— untitled =

03.08

Average Lap 0013 Laps fo go 008

¥ Elapsed 00-00:58 .61 fi : verage Mph 12

If you stop in the proper pit and are centered correctly you'll
be put up on jacks, and a stop watch will clock the length of the
pit. As soon as the Ferrari is let down, slam it into first and exit
the pit. When you exit the pit be sure to check your rear view
mirror for traffic.

Practice braking later and later as you enter the pit zone. The
faster you can enter and exit the pit, the more competitive you'll
be.

Gearing

After you've pretty well mastered a course, you can probably
shave off a bit more time by adjusting the gear ratios. Setting up
the gear ratios is a matter of experience. It all depends on the
type of course and your particular driving style.

You get fastest acceleration with the lowest gear speed. If the
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(1) Whistle McGee and Stocklon Stockman's current speed in MPH.
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course involves a lot of shifting, you might try using the lowest
gear speeds. If a course consists of a lot of third gear racing, try
using the fastest top end in third, or maybe the slowest 4th gear
speed.

To check a gear ratio change, first write down your best lap
time. Then, make your gear ratio change and drive 4 or 5 laps. If
the best lap clock has changed, the new gear ratio is good,
otherwise, put back the old gear ratio, and try something else.

How good are you?

The default course is a good track to learn on. Wide curves
make it easier to steer and there aren’t any long straights to build
up too much speed.

When you first start driving this course, a 2 minute lap is a
good time. As you get the hang of Ferrari Grand Prix, you should
be able to get the time under 1 minute. In fact, driving the
course in 3rd with no braking, and assuming you stay on the
course, will give you a time well under 1 minute. With the default
gearing, it's possible to drive the entire course in 4th with no
braking. This will give you an expert time of under 30 seconds.
Because of the way this course is designed, you will also win
races by driving in 4th. | expect it will take some time before you
can drive this course in 4th, but when you do, consider yourself
well along to mastering Ferrari Grand Prix.

You can go faster.

There are several places along this course where you can get
into 5th. Of course, you'll have to brake for the curves, but
probably not for the bends. If you can get your lap time under 25
seconds, you are a master Ferrari Grand Prix driver. {My best lap
time on the default course, as of this writing, is 22.80. I'm sure
that can be improved upon, although not sustained. Don’t
expect to drive a 23 second lap the first few sittings.)

Now having just read this, don't go out and try to drive the
course in 4th without braking. You won't be able to do it. You
might not be able to do it in 3rd either. That's okay, don't rush
it. Handicap the opponents and have a competitive race at your
current skill level. If you find yourself beating the opponents
every time, let them drive a little faster.

To know how fast you should be able to drive a course, let the
opponents drive a few laps flat out. Then check their best lap
times. These guys are fast, but they can be beat, although you
will not be able to go much faster than their best lap times.

The Opponents
Your opponents are great at thinking ahead and braking for
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curves. This makes them very strong on courses with lots of
curves. If you're a great driver, this is the type of course you
want to design.

They do, however, have a weakness. They brake for little
bends. This is why the default course is “easy” to win. If you
want a course where you can make up time against the
opponents, design a course that includes a long straight with a
couple of bends in it. The opponents will slow down and you can
whiz past them.

Going off the course

If both tires go off the course, the program will shift you into
first gear. You must get one tire back on the course before you
can shift into 2nd.

If the course disappears completely frem the screen, your
Ferrari will be put in neutral and you have to coast back to the
course. if you don't make it back to the course, your Ferrari is
considered damaged by geing off the course and the race is
over.

If you go off the course and head back (or if you simply turn
180 degrees on the track) you'll see that the course ends! This is
because the program never displays that part of the course that
is usually unseen, namely, the course that is typically behind
you. Don‘t get worried. This will help you notice which way to
drive when reentering the course. (You can't drive the wrong
way because the program will not display track pieces that are
behind you when going the proper direction.) If the program
tried to display the entire course, it would be hopelessly slow.



Tips and Common Mistakes

Ferrari Grand Prix may seem a little difficult at first. It's like
riding a bicycle, get up on a bike when you don’t know how and
you fall right over. Then, once you learn, you can't remember
what it was like not to know how. Here are a few tips to keep in
mind:

® ‘Watch the course at the farthest visible point. This will help
you stay ahead of the Ferrari.

@ Keep the course in front of you. If you start drifting off the
course, make a correction, don't wait.

@ |n curves, watch the white at the inside of the curve. Keep
this white centered in front of you.

- untitied
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® Try to memorize each course. This will help vou set up for
each curve.

@ Start slow on a course and learn each curve. If you design
a new course and try driving it at top speed —you're gonna get in
trouble.

@ Be gentle, be smooth. If you set up for each curve, you'll
find the Ferrari will almost steer itself. See “Advanced Training””
for a complete discussion on setting up for the curves.

@ |t is physically impossible to take a sharp curve at a high
speed. The answer is to slow down!

Some Common Mistakes
® Trying to go too fast. Start slow, learn your brake points,
work on one curve at a time. If a certain sequence is giving you
trouble, design a course with just that sequence and practice it.
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@ Entering a curve from the inside of the track. If you enter
from the inside, there will be no margin for error. You'll have to
jerk the wheel to make the curve and you'll probably over-steer.
This will force you to steer out of the curve. When this happens
you'll be lucky not to fly off the outside of the curve!

@ Exiting a curve late. As soon as you get “entering a curve”
mastered, you'll probably notice you're having trouble exiting a
curve. Remember to watch the course at the farthest visible
point so you can see when the curve ends. Try to smoothly
straighten the wheel, drifting to the outside or middle of the track.

® ‘Watching the other cars. It’s important to know where the
other cars are and to steer around them. It's more important to
see the next curve.

@ Getting impatient. There is a fine balance between driving
on the edge, and being patient. When you make a mistake and
one of the other cars makes a pass, the first impulse is to drive
like a maniac to quickly pass him back. But you can’t just snap
your fingers and be in front of him. Be aggressive. Be patient.

@ Forcing it. Racing consists of steering, shifting, braking,
setting up for curves, passing and taking pits. Learning each skill
separately takes time. Putting them all together takes more time.
Have fun learning, relax and take it easy, it'll come. The chapter,
"Advanced Training” will take you through each part of racing,
step by step.

Photo courtesy of Ferrari, italy
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Designing Courses

This chapter will discuss how to design a race course. The
best way to learn how to design a course is to be seated at your
Mac while you read this.

Let's get right to it. Launch Ferrari Grand Prix and, after
entering your name, select Show Track from the Edit menu. This
is the portion of the program where you can alter or design a
track. The track you're looking at is the default course and is also
‘saved on the disk with the name, “Ferrari Startup Course”.

At the upper left you'll see “Zoom Level'” and five button
choices, Clicking these buttons changes the scale of the track
being displayed. If the course becomes too big for the window,
the scroll bars become active. Go ahead and click each size. You
can use the smaller sizes to see an entire large course. The
largest size is best to use while designing a course.

Under Zoom Level are Cut, Copy, and Paste. These act the
same as Cut, Copy, and Paste on the Edit menu and are
repeated here for convenience. Maore on how to use them later.

Next, moving down is Track Length. The number here is in
feet.

Below Track Length is Insert Piece. This is used to put the
selected piece at the insertion box. (Keep reading, it will all be-
come clear.)

The next block of items are 14 pieces and a curve direction
changer.

The nine curve picces begin as right curves. Click the curve
girection changer now, and notice how the curves change. They
now turn to the left. Click it again and they return to right hand
turns. ¥'ll explain each of the pieces a little later.

Moving down again you'll see “Curve Radius” and five hutton
choices. Above the five bution choices are x10--> , 1007, 50,
25', 12', and 6.2, The x10--> means multiply the rest of the
numbers by 10. So the numbers stand for 1000 feet, 500 fest,
250 feet, 120 feet, and 62 feet. A curve with a 62 foot radius is
very sharp, 1000 feet radius is a gentle curve.

At the bottom of the screen is Track Width. There are two track
widths available, two lanes wide or three lanes wide. I'll refer to
the two widths as wide and narrow. The default course is mastly
wide pieces. The first button selects narrow, the second is wide.

The last item on this part of the screen is three letters, “TEH"
and three numbers, “000"”, TEH stands for Track End Heading
and the number is the actual compass heading of the last piece
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in the course. One restriction on designing a course is that it
must end facing north, or straight up, which is 000 degrees.

Okay, make sure you have the largest zoom level selected.
Look at the course and you'll see the start/finish symbol.

This lets you know the direction of the course. Also notice
that you can see individual pieces when the largest zoom level is
selected. You should also be abie to notice narrow and wide
pieces.
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{1) This box shows the cuirent position of Stockton Stockmarn.

(2} This box shows the current position of Whistle McGos.

[3) This is the insertion box. Upon entry to Show Track, it displays your Ferrari's
currant position. During sditing, it shows whera you are warking.

(4) This is 2 wide piace. Most of this course is made with wide pisces.

(5) This is tha Start/Finish piece. It 8lso happens to be a narrow piece.

[6) This is the direction arrow. It shows which wey the cars race.

(7) This is the pit piece. Be sure to includa one if you want to pit.

(8) This is the curva dirsction changer.

There is also a small black box on one of the pieces. This is
the insertion box. Click along the course at different spots and
vou’ll notice the box will go wherever you click. The box actually
draws at the beginning of a piecs.

That was a brief description of all the tools and items used in
designing a course. Now it's time to use these tools to create a
new course. First thing to do is go to the Edit Menu and select
Clear. The program will ask, "“Clear course from memory?”, say
ves.

The course you’ll design will be a simple oval. To begin, click
the long straight, which will make it invert. You will find the long
straight to the right of the curve direction changer. When a piece
inverts, it means that piece has been selected and will be used
when “Insert Piece’ is clicked. Go ahead and click Insert Piece.

Notice that a wide straight has been added to the course. Add
three more straights by clicking Insert Piece three more times.

Make sure the black arrow on the curve changer is pointing to
the left, then click the 45 degree curve piece. 45 degrees means
this curve selection will produce a curve that will go around a
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circle 45 degrees. There are three factors that make a particular
curve; the degrees, which | just described, the track width,
which is wide or narrow, and the radius, which decides how
sharp a curve is.

Click Insert Piece. Oops, the track went off the top of the
window. Click the largest zoom size {which is already selected,
but click it anyway). This re-draws the course putting the
insertion box at the middle of the track window. You could also
have moved the course down using the scroll bar. Another thing
to notice is that the 45 degree piece actually consists of three
pieces. There are really only three degree pieces, 5, 10, and 25
degrees. The 45 degree piece is made up of a 25 degree piece
and two 10 degree pieces. I've included all the other sizes for
convenience. It's best to always use the largest degree size for a
particular need. For example, if you want to put a 40 degree
curve in a course, use the 40 degree piece rather than eight 5
degree pieces. When you select a curve that is made up of more
than one piece the program will put the best-locking combination
in the course.

Right, let's put another 45 degree piece in the course, click
Insert Piece. Notice TEH now reads 270 which means the last
piece in the course is facing west. If you want to see the
complete course, click a smaller size zoom level. Return to the
largest zoom size and add two straights. (Click the long straight
piece and click Insert Piece twice.) Now let's put a straight in the
middle of the curve. Here’s what to do: first, move the insertion
box by pointing at the beginning of the third curve piece, and
clicking. The screen should look like this:
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Make sure the straight is selected and click Insert Piece. Now
click on the last piece and put two more 45 degree pieces in.
Click the largest zoom level again to bring the end of the course
back into the screen. Click on the bottom scroll bar to make the
entire course visible.
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Add a couple straights, the pit piece, and a couple more
straights. {I'm not geing to tell you exactly how, you know by
now how to do this.)

Sometimes it becomes confusing which direction curve to use.
Locking at the course now, it would appear that the curve
direction would need to be changed in order to turn toward the
start/finish piece. On the contrary, begin at the start/finish and
trace along the course until the end, visualizing the direction you
would be facing. In this case, you're facing down or south. To
turn toward the start/finish you would turn left, correct? So even
though a left hand curve looks wrong, it's actually correct.

Now let’s try out the copy and paste features. We'll copy and
paste the second curve we designed. First, we'll select the entire
curve. Here’s how: click on the first curve piece and drag,
holding the mouse button down, over the entire curve, which is
six pieces long. It looks like this:
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Mow click copy. This copies the selected pieces into memory,
and doesn’t effect the course. Now move the insertion box to
the end of the course by clicking on the last piece of the course.
Next, click paste. (Also click the largest zoom level button to
bring the new work into the window.) This takes whatever was
copied {or cut) last and adds it at the insertion box. I've just
decided that wasn’t such a great thing to do. To take back your
last action, use the undo option on the Edit menu. Try it. You've
still got those pieces in memory so now click paste again, to
put’em back in the course. Note: you cannet undo an undo
command,

Put 2 couple more straights in the course and click the scroll
bar. It now looks like this:
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The cut option will take out the currently selected piece, or
pieces. Try it now. Cut takes the piece(s) out of the course and
puis it in a buffer, just like copy. Clicking paste will put whatever
was cut back into the course. You would use this option to take
an area of track out of a course and possibly put it back in at

another spot.
Add a couple more 45 degree pieces. The track now looks like

this:
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You're almost done now. You just need to line up the start
and end. Actually, the program doesn’t really care if the start
and end line up as long as “TEH" is 000, which it is. But for the
sake of esthetics, try putting in short or long straights to aline
the start and finish.

Now you've completed your first course. Click the close bax ta
exit and drive your new course. I'll wait...

Not too exciting is it? Well, that's okay, you've just learmed
how to use all the course designing toals, go to work and create
something great!

Notes on the Show Track option and on designing courses.

Upon selecting Show Track, the insertion box will be
positioned on the piece where your Ferrari currently is. So, if
during a race you get cornfused about where on the course you
are, take a quick look at Show Track and you can see exactly
where you are.

@ Don't change the course, even slightly, during a race. Any
time the course is changed your current position, and the
positions of the opponents, is lost. You'll all be restarted,
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® When you select Show Track, the course is copied into
memory. If you change the course, and before you exit, decide
you want the original course back, select revert. This will return
the track to the way it was when you selected Show Track. If
you decide you didnt mean to revert, you can select undo. (You
can still revert, then undo, revert, undo...) Even if you select
revert, current car positions are lost. {See above.)

@® You can force a width change by inserting the wide to
narrow or narrow to wide pieces.

Or simply click the track width button to change widths. The
program will automatically insert the proper wide to narrow or
narrow to wide pieces when you exit Show Track.

@ If you accidentally insert a piece you didn’t want, use Undo
to get rid of it, instead of cut.

@ Changing the curve radius within a curve is very difficult to
drive. {This is either a suggestion or a warning, depending on
what you're after.)

@® Shorter courses are generally more fun to drive, at least
while learning.

@® Curve speeds are basically 5th gear for 1000 foot radius,
4th gear for 500 and 250 foot radius, 3rd gear for 120 foot radius,
and 2nd for 62 foot radius curves.

@ You can't “Save” while designing a course. This can be
inconvenient. (Sorry about that.) In order to save a course, you
must first exit the Show Track option. You can't exit Show
Track unless the last piece is facing north. This is okay if you've
finished a course, but if you have to stop half way through, it's
trouble. Here's what to do, look at the “REH"" number and use
“Insert Piece” to enter a curve that will make the TEH equal 0C0.
{if TEH is 015 insert a left 15 degree curve.) Now you can click
the close box and save the course you're working on. When you
return, load your course and cut out the curve you added to
make TEH equal 000. Now you can continue where you left off.

® A course must be at least nine pieces long. If you design a
course that is less than 9 pieces, the program performs a revert
upon exit of Show Track.

® You can't cut the start/finish piece and you can’t put more
than one pit piece in a course.

® For best results, put the pit piece at least 5 pieces away
from either side of the start/finish piece. Also, courses should be
at least 20 pieces long.
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Designing Backgrounds

The mountains in the background can be easily changed to
anything you can imagine. Here's how: first duplicate the file
called, “Original.Bkg”. You can do this from the Finder. Next
run MacPaint and load, “"Copy of Original.Bkg”. You'll see 4
rectangles of background scenery. Draw anything you like, but
be sure to stay inside the rectangles.

Also, don't forget to aline the right side of the first rectangle
with the left side of the next. Continue alining the right of one
rectangle to the left of the next one down, until the last one
which alines with the left of the first rectangle.

The only restriction on the name of a background is that it end
with the extension, "'.Bkg”'.

To load a background, select “Load Background” from the
Game menu in Ferrari Grand Prix. That's it, give it a try.




The Courses

There are five courses included with Ferrari Grand Prix. They
are: Ferrari Startup Course, Fast Course, Portuguese Grand Prix,
ltalian Grand Prix, and Back and Forth.

Whenever you load a track, you might want to select “"Show
Track™ to take a quick look at it.

Ferrari Startup Course

This is the default course that comes up when you launch
Ferrari Grand Prix. This course is all wide pieces for ease of
steering. All curves can be taken in 4th gear. The two main
straights both have bends in them which slows the opponents
down. This course is fairly easy to win.

Fast Course

This course is basically an oval, with a 180 degree curve added
in the back stretch. The four main curves are 5th gear curves.
The curves in the back stretch are 4th gear curves. The entire
course is made up of narrow pieces.

The only place to make up ground on the opponents is in the
4th gear curves. Try to brake later and accelerate earlier at these
curves.

This course is difficult to win if you make even one mistake.

Portuguese Grand Prix

This course has lots of straights and curves. You must
memorize this course to do well.

This course also requires a lot of braking and shifting. You'll
use gears 3, 4, and b.

You can't be lazy in some of these curves because they're
radius changes during the curve. This course is hard, but winable.

Italian Grand Prix

This course is deceiving because it looks like long straights and
gentle curves. If you look closely, you'll see three devilish
chicanes in the straights. These are 2nd and 3rd gear curves, and
you have to brake early to slow down for them. Once you master
these chicanes, this course is easy to win.

The last curve on this course is a sucker curve. It starts out as
a 4th gear curve, then changes to a 5th gear curve with one
more 4th gear piece thrown in. It's very easy (and embarrasing}
to go off the inside of this curve. Watch out.

With a good gear set up, cautious, mistake-free driving, and a
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good attitude, you can beat the opponents by 2 seconds each
lap. With a little pushing, you can do a lot better.

Hint: the third chicane is guite a bit easier (and therefore faster)
than the first two chicanes. This is a great place to bury the
opponents.

Back and Forth

This course is obviously frivolous. It is good practice for high
speed racing, with a few tricks thrown in.

On the second half of the course, just drive flat out and stay
on the course. You can’t make up much time here, just try not
to lose any.

You can go a lot faster than the opponents in the back and
forth straights by braking later and accelerating earlier.

® High speed courses force you to drive flawlessly. There are
two reasons for this. One, if you go off the course and get put
into first, you'll be going 15 mph and the opponents are probably
doing 200+ mph. You lose a lot of ground when this happens.
Two, catching up is nearly impossible because both you and the
opponents are traveling at the top speed most of the time.

@ Slower courses are more forgiving. You don’t lose much
ground if you get forced into 1st when your opponents are going
40 mph. Also, a course with a lot of curves gives you a chance
to out-brake your opponents, and therefore, make up ground.
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About Ferrari Grand Prix

Ferrari Grand Prix represenis my second effort on the Mac.
(My first Mac program is Fokker Triplane Flight Simulator.) |
began the project thinking Grand Prix might take me about 2
months to write. Alas, 10 months later, I'm scrambling to finish it
before the Christmas season arrives.

The hardest thing on this program was keeping the two
opponent cars on the course. (Doesn’t sound hard, does it?)

It was guite frustrating to see Whistle McGee cutting a curve
and whizzing past me during testing. Two weeks of day and
night toil and not a few coffee mugs later, | put a stop to it.

A word about testing: since there is nearly an unlimited
number of courses that can be designed, it is impossible to fully
test the program. |'ve tried to test as many “‘worst-case’
situations as | could think of, but I'm sure there are some
anomalies waiting to be discovered.

You might remember a strange train in the “Gumby" television
series from many years ago. This train had the special nack of
picking up a piece of track it had just driven over and put another
piece down in front of itself. Thus, it could drive anywhere. That
idea is roughly analogous to the situation in Ferrari Grand Prix.
This individual track piece approach for the courses was decided
on early, and is the backbone of Grand Prix. The program is only
concerned with, and only draws, the four pieces immediately in
front of your current position. Most of the time this works guite
well because four pieces reaches far enough away to look
realistic. However, if you use a couple of 5 degree 62' radius
pieces you'll see a rather shocking sight—a dead end.

The Ferrari can nearly reach the farthest piece before the
program has a chance to put more pieces in front of your
position. Of course, this is a worst case situation, and can be
worked around. Use 10 or 25 degree pieces instead of individual
5 degree pieces.

| don’t encourage you to drive faster out on the freeway or
around town, just because you get good at Ferrari Grand Prix.

Enjoy Ferrari Grand Prix. It is about a year of my life. | hope
you'll send me any comments or suggestions you have.
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